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ВВЕДЕНИЕ 

Развитие современных оптоэлектронных, фотонных и сенсорных 

технологий неразрывно связано с освоением методов создания и 

функционализации тонких плёнок — слоистых структур толщиной от долей 

нанометра до нескольких микрометров. В отличие от массивных материалов, 

тонкие плёнки демонстрируют уникальные оптические, электронные и 

механические свойства, обусловленные квантовыми размерными эффектами, 

межфазными взаимодействиями и возможностью точного контроля состава и 

структуры на атомарном уровне. Благодаря этим особенностям 

тонкоплёночные структуры легли в основу лазерных зеркал и просветляющих 

покрытий, плазмонных сенсоров, гибкой электроники, защитных 

нанокомпозитов и множества других устройств, определяющих 

технологический прогресс в XXI веке. Нанотехнологии тонких плёнок как 

дисциплина объединяют физику конденсированного состояния, 

материаловедение и оптику, предоставляя инструментарий для 

проектирования функциональных поверхностей с заданными 

характеристиками. 

Предлагаемый лабораторный практикум предназначен для студентов 

старших курсов бакалавриата и магистратуры, обучающихся по укрупнённой 

группе направлений подготовки 12.00.00 «Фотоника, приборостроение, 

оптические и биотехнические системы и технологии», и рекомендуется к 

использованию в объёме семестрового курса. Практикум включает цикл 

взаимосвязанных экспериментов, охватывающих ключевые этапы работы с 

тонкоплёночными материалами: от подбора и характеризации подложек 

методами оптической спектроскопии до получения функциональных слоёв, 

анализа морфологии с помощью данных сканирующей электронной 

микроскопии и исследования волноводных свойств полимерных плёнок. 

Особенностью методического подхода является намеренный отказ от готовых 

формул для обработки результатов: студентам предлагается самостоятельно 

выводить расчётные соотношения и применять математический аппарат 

теории погрешностей, что способствует формированию навыков научного 

мышления и критической оценки экспериментальных данных. Цель пособия 

— сформировать у обучающихся целостное понимание триады «технология 

изготовления — наносистема — функциональные свойства» применительно к 

тонким плёнкам, а также практические компетенции в области их синтеза и 

комплексной оптической диагностики. Освоение этих навыков создаёт основу 

для дальнейшей научно-исследовательской деятельности в области 

нанофотоники, оптической сенсорики и разработки функциональных 

покрытий. 

Реализация данного практикума проходит на оборудовании лаборатории 

«Фотофизика поверхности», существующего в составе Международного 

научно-образовательного центра физики наноструктур Университета ИТМО. 
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Научные корни лаборатории уходят в Государственный оптический 

институт имени С.И. Вавилова, где под руководством члена-корреспондента 

РАН Алексея Михайловича Бонч-Бруевича формировался коллектив, 

заложивший основы исследований взаимодействия лазерного излучения не 

только с объёмными средами, но и с границами раздела фаз – поверхностями 

твёрдых тел, тонкими слоями и адсорбированными молекулами.  

С начала 1960-х годов А.М. Бонч-Бруевич сосредоточил усилия на физике 

лазеров и их взаимодействии с веществом. Совместно с сотрудниками он 

создал первый в СССР лазер на неодимовом стекле, который был серийно 

освоен отечественной промышленностью в 1964 году — раньше, чем начался 

промышленный выпуск аналогичных лазеров за рубежом. За разработку основ 

создания лазеров на неодимовом стекле и освоение их серийного производства 

в 1974 году он был удостоен Государственной премии СССР. С 1962 года Бонч-

Бруевич систематически изучал процессы воздействия лазерного излучения на 

поглощающие среды, разработал теорию этих процессов и заложил основы 

лазерной обработки материалов, в первую очередь металлов.  

Параллельно с исследованиями поглощающих сред Бонч-Бруевич изучал 

действие мощного излучения на прозрачные и слабопоглощающие материалы. 

В 1972–1976 годах в этих работах были обнаружены новые нелинейные 

эффекты, разработан статистический подход к описанию оптического 

разрушения диэлектриков и сформировано новое направление, названное им 

«силовой оптикой».  

Научная школа А.М. Бонч-Бруевича получила статус ведущей научной 

школы России по итогам первого конкурса 1996 года и с тех пор неоднократно 

подтверждала его, последовательно развивая направление физики 

поверхностных явлений. 

В первую очередь это связано с тем, что в 1970–1990-е годы коллектив 

лаборатории внес значительный вклад в становление отечественной фотоники 

и оптоэлектроники. В работах Татьяны Константиновны Разумовой и её 

группы были обнаружены и исследованы изменения в спектрах поглощения 

первого лазерного материала — рубина, а впоследствии изучены 

фотоиндуцированные обратимые преобразования стереоструктуры 

многоатомных органических молекул и генерационные характеристики 

органических сред для перестраиваемых лазеров. Впоследствии эти 

исследования были использованы для изучения термо- и лазерно-

индуцированных перестроек молекулярных слоев полиметиновых 

(цианиновых) красителей. 

В работах группы Валерия Васильевича Хромова исследованы спектры 

поглощения атомов в газовой фазе, динамический эффект Штарка в атомах 

щелочных металлов в монохроматических и немонохроматических полях 

излучения. Обнаружено и подробно исследовано явление четырехволнового 

взаимодействия в резонансных средах, ставшего впоследствии основой 
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динамической голографии. Группа активно участвовала в исследовании 

соударений атомов в интенсивных полях излучения, приведших к 

формированию нового научного направления – радиационных столкновений. 

При этом был открыт новый тип оптического просветления резонансной 

среды, основанный на нелинейности ландау-зинеровского типа. Исследованы 

явления, возникающие при взаимодействии резонансного излучения с 

адсорбированными на поверхности атомами – фотодесорбция, фотодиффузия, 

и открытое им явление фотоатомной эмиссии — фотоиндуцированный отрыв 

собственных атомов с поверхности металлов. 

Владимир Леонидович Комолов с сотрудниками предложил 

статистическую модель оптического пробоя прозрачных диэлектриков, 

ставшую ключевым вкладом в понимание нелинейных процессов в 

оптических материалах под действием интенсивного излучения. Его 

исследования охватывали оптический пробой полупроводников и 

диэлектриков, неравновесную функцию распределения свободных носителей 

и электронно-тепловую генерацию дефектов в твёрдом теле. Разработанная 

модель не только объяснила физику пробоя реальных оптических материалов, 

но и легла в основу методов контроля качества и очистки оптических стёкол, 

внедрённых в ГОИ для повышения лучевой прочности элементов оптических 

систем. За этот цикл работ В.Л. Комолов был удостоен премии Ленинского 

комсомола в 1979 году. 

Сергей Григорьевич Пржибельский заложил основы теоретического 

описания нелинейных оптических явлений в немонохроматических полях 

лазерного излучения. Первым обратил внимание и начал исследовать роль 

внутриспектральной корреляции гармоник в протекании нелинейно-

оптических явлений. Он выполнил пионерские теоретические работы в новой 

области радиационных соударений атомов, а также предсказал явление эха в 

полусоударениях атомов, дал теоретическое описание фотодесорбции и 

фотодиффузии атомов по чужеродной и собственной поверхности элементов, 

разработал теоретические основы нового метода изучения субмикронных 

частиц – флуктуационной микроскопии. 

Переход коллектива из Государственного оптического института имени 

С.И. Вавилова в ИТМО стал частью стратегической инициативы по созданию 

в Санкт-Петербурге центра компетенций в области фотоники. В 2002 году по 

приглашению ректора Владимира Николаевича Васильева академик А.М. 

Бонч-Бруевич и ключевые сотрудники его лаборатории присоединились к 

университету. На базе этого коллектива была создана лаборатория 

«Фотофизика поверхности», что обеспечило преемственность научной школы 

и её интеграцию в университетскую образовательную среду. 

В 2006 году лабораторию «Фотофизика поверхности» возглавил 

профессор Тигран Арменакович Вартанян — физик-теоретик, признанный 

специалист в области взаимодействия света с веществом и плазмоники. Он 
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выполнил первые теоретические расчёты нелинейных оптических эффектов 

при отражении интенсивного резонансного излучения от границы 

разрежённой резонансной среды, а также инициировал и теоретически 

обосновал метод измерения времён дефазировки коллективных электронных 

возбуждений в наноразмерных металлических частицах. Под его руководством 

лаборатория сместилась к междисциплинарным исследованиям, 

объединяющим физику, химию и биологию, что нашло отражение в составе 

авторов публикаций по биосенсорике, ДНК-наномашинам и 

метаповерхностям. 

В 2013 году коллектив лаборатории был включён в Реестр ведущих 

научных и научно-педагогических школ Санкт-Петербурга под названием 

«Взаимодействие оптического излучения с веществом», что официально 

закрепило преемственность научной традиции, заложенной А.М. Бонч-

Бруевичем, и подтвердило переход к современным направлениям 

исследований поверхностных и наноструктурированных систем. 

В 2010-х годах с формированием нового поколения защитившихся 

кандидатов наук и молодых исследователей лаборатория значительно 

расширила спектр работ, сосредоточившись на создании функциональных 

композитов на основе наночастиц благородных металлов (золота и серебра). 

Уникальность таких структур обусловлена коллективным откликом 

электронов проводимости наночастиц на внешнее излучение: при резонансном 

возбуждении вблизи наночастицы формируется область с плотностью энергии 

электромагнитного поля, превышающей плотность в падающей волне на 

порядки. Это позволяет существенно усиливать поглощение, люминесценцию 

и нелинейные оптические процессы в функциональных слоях, расположенных 

в ближнем поле плазмонных наноструктур. 

В лаборатории «Фотофизика поверхности» сейчас исследуются 

физические явления, связанные с поверхностями: 

• хиральные и анизотропные метаповерхности;

• методы усиления хемилюминесценции с помощью поверхностных

наноструктур;

• методы усиления слабых оптических откликов и сигналов с

помощью поверхностных наноструктур;

• спектры атомов вблизи поверхности;

• неорганические, органические и композитные тонкие плёнки на

поверхности;

• взаимодействие лазерного излучения с поверхностными 

наноструктурами;

• кинетика прохождения наночастиц через границы раздела сред;

• оптические микрорезонаторы с гигантской добротностью.

Это позволяет разрабатывать новые устройства и технологии, такие как 
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• технологии создания оптических покрытий с заданными

свойствами, прочностью и отражением;

• ограничители для защиты от мощного лазерного излучения;

• сверхзащищённые метки для борьбы с контрафактной

продукцией;

• оригинальные сенсоры химических веществ для криминалистики;

• ультрачувствительные сенсоры биологических молекул для

медицины;

• микро- и нанолазеры.

Преемственность научной школы получила новое подтверждение в 2025 

году: научно-педагогическая школа под руководством Т.А. Вартаняна была 

включена в федеральный реестр ведущих научных школ Российской 

Федерации под названием «Плазмонные наноструктуры». Это признание 

отражает эволюцию исследований лаборатории — от фундаментальных работ 

по взаимодействию излучения с веществом к созданию функциональных 

композитов, где плазмонные наноструктуры служат ключевым элементом 

управления оптическими свойствами на наномасштабе. 

Таким образом, лаборатория «Фотофизика поверхности» остаётся на 

переднем крае исследований в области поверхностных явлений для 

нанотехнологий, сочетая глубокие физические изыскания с разработкой 

технологий, востребованных в оптоэлектронике, сенсорике и биомедицине. 
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1 ЛАБОРАТОРНАЯ РАБОТА  

«ОПРЕДЕЛЕНИЕ МАТЕРИАЛА ПОДЛОЖЕК НА ОСНОВЕ 

ИЗМЕРЕНИЯ СПЕКТРОВ ОПТИЧЕСКОЙ ПЛОТНОСТИ» 

 

Цели работы: 

1. Изучить методику измерения спектров оптической 

плотности на спектрофотометре СФ-56. 

2. Научиться определять материал подложек (стекло, 

плавленный кварц, сапфир) на основе полученных спектров. 

 

1.1 Теоретическая часть 

Выбор материала подложки играет ключевую роль при разработке 

оптических и фотонных устройств, особенно в области ультрафиолетовой 

(УФ) и видимой спектроскопии, нанофотоники, а также проведении научных 

исследований. Разные диэлектрические материалы, такие как оптическое 

стекло, плавленый кварц (fused silica) и синтетический сапфир (Al₂O₃), 

обладают существенно различающимися спектральными характеристиками 

пропускания и отражения, обусловленными как фундаментальными 

свойствами вещества (ширина запрещённой зоны, наличие примесей), так и 

макроскопическими параметрами (показатель преломления, шероховатость 

поверхности). 

Оптическое стекло, несмотря на высокую прозрачность в видимой 

области, практически непрозрачно в УФ-диапазоне из-за поглощения, 

вызванного электронными переходами в примесях оксидов железа и других 

металлов. Однако даже при отсутствии поглощения прозрачные материалы 

могут демонстрировать различную оптическую плотность из-за 

отражательных потерь, зависящих от показателя преломления. 

Для экспериментальной оценки этих свойств используется 

спектрофотометрия – метод, позволяющий измерять зависимость 

коэффициента пропускания (или оптической плотности) от длины волны. 

Спектрофотометр СФ-56, объединяющий УФ- и видимый диапазоны (190–

1100 нм), обеспечивает возможность одновременно оценить как спектральные 

границы поглощения, так и вклад отражения в общую экстинкцию материала. 

Спектрофотометр применяется при проведении физических, 

медицинских, биологических исследований, а также при контроле качества 

готовой продукции и контроле продукции по ходу технологического процесса 

в оптической, химической, микробиологической, фармацевтической и других 

отраслях промышленности. 

Принцип действия спектрофотометра (рис. 1) основан на измерении 

отношения двух световых потоков: светового потока, прошедшего через 

исследуемый образец, и потока, падающего на исследуемый образец. Для 

повышения точности измерения, а также устранения влияния рассеянного 

света регистрируется интенсивность сигнала при перекрытии света от 

источника излучения. 
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Рисунок 1 – Функциональная схема спектрофотометра СФ-56 

 

В монохроматический поток излучения поочерёдно вводятся «тёмная 

зона», расположенная на блоке светофильтров, контрольный образец и 

исследуемый образец. 

При введении контрольного образца изменением ширины щели и 

чувствительности блока ФПУ автоматически устанавливается определённый 

уровень сигнала. При введении в поток излучения исследуемого образца 

световой поток изменяется пропорционально коэффициенту пропускания 

образца. С выхода блока ФПУ снимают сигналы. 

Коэффициент пропускания исследуемого образца Т в процентах 

рассчитывается по формуле: 

T = (Uо – Uт) / (Uп – Uт) * 100% , 

где Uп – напряжение, пропорциональное световому потоку, падающему на 

образец; Uо – напряжение, пропорциональное световому потоку, прошедшему 

через образец; Uт – напряжение, пропорциональное темновому току блока 

фоторегистрирующего устройства. 

Таким образом, на каждой длине волны поочередно измеряется 

интенсивности: 

- “темной зоны”, которая формируется перекрытием света в блоке 

светофильтров,  

- света от лампы,  

- света, который прошел через образец. 
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При работе со спектрофотометром важно понимать, как взаимодействуют 

свет и образец. Когда свет проходит через материал, он может либо 

пропускаться, либо поглощаться, либо отражаться. Эти три процесса 

взаимосвязаны и описываются следующим соотношением: 

R + T + A = 100% . 

1. Пропускание (T) – это доля света, которая проходит через 

образец. Обычно оно выражается в процентах или в виде десятичной дроби. 

Пропускание определяется как отношение интенсивности света, прошедшего 

через образец Iо, к интенсивности света, падающего на образец Iп: 

T= Iо / Iп . 

2. Поглощение (A) – это доля света, которое поглощается образцом 

и определяется внутренней энергетической структурой образца.  

3. Рассеяние (R) – это доля света, которая рассеивается от 

поверхности образца, в частности зеркально или диффузно отражается в 

зависимости от шероховатости поверхности.  

Как видно, прямое измерение поглощения на спектрофотометре 

невозможно. Поэтому величину, которую измеряет прибор, определяют как 

экстинкцию – ослабление интенсивности света, прошедшего через образец, за 

счет процессов, как поглощения, так и рассеяния. Таким образом, экстинкцию 

(Е) на основе пропускания можно определить как 

E = A +  R = 100% – T . 

Очень часто при проведении спектрофотометрических измерений 

рассеянием пренебрегают. Спектр рассеяния для прозрачных материалов, из 

которых изготовляются подложки или кюветы, преимущественно 

определяется отражением света и, согласно формулам Френеля, зависит от 

показателя преломления материала. И для прозрачных образцов в видимом 

диапазоне спектр отражения представляет собой пологую линию, показывая, 

что доля отраженного света не меняется в указанном спектральном диапазоне. 

В связи с этим влияние отражения является предсказуемым и/или 

незначительным. 

Для многих образцов, особенно тех, которые обладают высокой степенью 

поглощения, доля света, рассеянного от поверхности, становится 

незначительной по сравнению с количеством света, поглощаемого образцом. 

Когда материал сильно поглощает свет, даже небольшая доля рассеянного 

света не оказывает существенного влияния на итоговые измерения. Это 

позволяет исследователям сосредоточиться на поглощении, не учитывая 

рассеяние. 

Оптическая плотность (D) — мера ослабления света объектами. 

Вычисляется как десятичный логарифм отношения потока (или 

интенсивности Iп) излучения, падающего на объект, к потоку (или 

интенсивности Iо) излучения, прошедшего через него (отразившегося от него): 

D = –lg (T) = lg (1 / T) = lg(Iп / Iо) . 

Оптическая плотность может варьироваться от 0 (полное пропускание) до 

бесконечности.  
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Рисунок 2 – Оптическая схема спектрофотометра СФ-56 

 

В качестве источников излучения для спектрофотометра (рис. 2) 

используется дейтериевая лампа 1 для работы в области спектра от 190 до 380 

нм и галогенная лампа 3 для работы в области спектра от 380 до 1100 нм. 

Смена источников излучения производится автоматически при помощи 

плоского зеркала 2, которое в рабочем положении перекрывает световой поток 

от лампы 1, направляя на входную щель монохроматора световой поток от 

лампы 3. 

При помощи эллиптического зеркала 4 и плоского зеркала 5 светящееся 

тело каждого источника излучения проецируется на входную щель 8 

монохроматора с увеличением 5 (×5). 

Для уменьшения рассеянного света и устранения высших порядков 

дифракции перед монохроматором установлен блок со светофильтрами 6. 

Линза 7 служит для согласования оптических систем осветителя и 

монохроматора.      

Двойной монохроматор построен по горизонтальной схеме с постоянным 

углом отклонения 12° со сложением дисперсий и состоит из двух вогнутых 

дифракционных решёток 12 с переменным шагом и криволинейным штрихом 

и сферического зеркала 9, выполняющего роль средней щели. 

Сканирование спектра осуществляется одновременным поворотом 

решёток обоих монохроматоров на одинаковый угол. 

На входную щель 11 проецируется изображение входной щели с 

увеличением 1. 

Оптическая система кюветного отделения и приёмного устройства, 

состоящая из трёх торических зеркал 10, 13, 16, формирует изображение 
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выходной щели в кюветном отделении в плоскости установки образца с 

увеличением 1 и изображение выходного зрачка на фотоприёмнике 14 блока 

ФПУ с увеличением 0.2. На входе и выходе кюветного отделения установлены 

защитные пластины 15. 

Оптическая система рассчитана таким образом, что при установке в 

кюветном отделении приставки зеркального отражения или кюветы с 

исследуемым веществом не происходит изменения размера светового пятна на 

фотоприёмнике. В качестве фотоприёмника излучения используется фотодиод 

с приёмной площадкой размером 7×7 мм, который развёрнут на угол 19 ° для 

устранения многократных отражений от светочувствительной поверхности. 

 

1.2 Порядок работы 

Оборудование и материалы: 

• Спектрофотометр СФ-56 

• Подложки  

 

1. Включите спектрофотометр с помощью зеленой клавишей на блоке 

питания.  

2. На компьютере запустите с рабочего стола программу СФ-56. 

3.  В верхнем горизонтальном меню выберете Прибор → Подключиться. 

Программа проверит наличие связи компьютера со спектрофотометров и 

запустит процедуру настройки, которая включает коррекцию положения 

дифракционных решеток монохроматора. В видимом диапазоне дейтериевая 

лампа имеет интенсивную узкую полосу на 656.1 нм – по ней корректируется 

соответствие угла поворота решеток определенной длине волны. Стабильная 

работа спектрофотометра обеспечивается через 30 мин после его включения, 

так как это время необходимо для разогрева дейтериевой лампы. 

3. Убедитесь, что поверхности подложек чистые и сухие. Удалите 

отпечатки пальцев, пыль и волокна с помощью мягкой салфетки и этилового 

спирта. Не касайтесь оптических поверхностей пальцами, можно брать 

подложки за торцевые части. Закрепите подложку в держателе 

перпендикулярно подающему свету и установите его в кюветное отделение, 

которое следует закрыть. Цвет метки подложки должен соответствовать 

идентификатору в отчёте. 

4. Выберите режим «Сканирование», так как он позволяет регистрировать 

полный спектр в диапазоне 190–1100 нм с заданным шагом (рекомендуется 1 

нм). Убедитесь, что выбрана измеряемая величина «Оптическая плотность 

(D)». Нажмите «Старт» и дождитесь завершения сканирования (обычно 1–2 

минуты). Сохраните график: Файл → Сохранить как… 

5. Повторите пункты 3–4 для всех подложек. 

6. В отчёте необходимо представить один общий график, на котором все 

спектры оптической плотности построены в одной системе координат. Это 

позволяет визуально сравнить положение края поглощения каждого 
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материала, уровень оптической плотности и относительные различия, 

обусловленные как поглощением, так и отражательными потерями. 

7. Для каждого спектра необходимо определить длину волны, начиная с

которой наблюдается резкое возрастание оптической плотности — это 

называется краем поглощения (λкр). Графически край поглощения можно

найти как точку, где кривая D(λ) начинает монотонно и быстро расти при 

уменьшении длины волны. Точно край поглощения определяется как длина 

волны, при которой D ≈  0.1–0.2 (порог выбран условно, но достаточно 

чувствителен к началу поглощения). 

8. На основе проведённого сравнения каждый спектр должен быть

соотнесен с определенным материалом. 

1.3 Вопросы для самопроверки 

1. Что такое оптическая плотность и как она связана с

коэффициентом пропускания? 

2. Почему невозможно напрямую измерить поглощение образца на

спектрофотометре? 

3. Каковы характерные особенности спектра пропускания стекла по

сравнению с кварцем? 
4. Для чего нужна дейтериевая лампа в спектрофотометре?

5. Как по спектру оптической плотности определить, где находится

край полосы поглощения? 

6. Что такое "темновой ток"? Как он влияет на результаты 
спектрофотометрических измерений? 

7.         Если увеличивать толщину образца, как будет меняться спектр 
оптической плотности? 

8. Как показатель преломления материала влияет на спектр 
оптической плотности? 

9. Может ли оптическая плотность быть отрицательной, и что это 
означает? 

10. Как рассеянный свет влияет на точность измерений в УФ-

области? 

11. Почему в спектрофотометрах используют двойные 
монохроматоры? 

12. Перечислите прозрачные материалы в видимой области спектра, 
которые могут быть использованы для создания подложек или кювет. 



- 15 - 
 

2 ЛАБОРАТОРНАЯ РАБОТА  

«АНАЛИЗ ВЛИЯНИЯ СКОРОСТИ ВРАЩЕНИЯ ПОДЛОЖКИ НА 

ОПТИЧЕСКИЕ СВОЙСТВА СЛОЕВ, ПОЛУЧЕННЫХ В ПРОЦЕССЕ 

СПИН-КОАТИНГА» 

 

Цель работы: получить навыки работы со спин-коатером для нанесения 

тонких пленок на стеклянные подложки. 

 

2.1 Теоретическая часть 

Нанесение тонких пленок методом спин-коатинга (spin-coating, иногда 

встречается термин «центрифугирование») — это распространённая техника 

получения равномерных покрытий на плоских подложках. В процессе 

подложка с нанесённым раствором вращается на высокой скорости (обычно 

>600 об/мин), в результате чего центробежная сила и поверхностное 

натяжение распределяют жидкость по поверхности, а испарение растворителя 

оставляет тонкую твёрдую плёнку. 

Спин-коатинг используется в широком спектре отраслей 

промышленности и технологических секторов, а также лабораторных 

исследованиях. Его основное преимущество перед другими методами 

заключается в способности быстро и легко производить тонкие пленки. 

Применение спин-коатинга в органической электронике и нанотехнологиях 

является широко распространенным, базируется на основных принципах, 

которые используются в полупроводниковой промышленности. 

Процесс спин-коатинга можно разделить на 3 основных этапа: 

1. Нанесение раствора на подложку. 

2. Распределение и истончение жидкого слоя на вращающейся 

подложке. 

3. Испарение растворителя. 

На начальном этапе раствор наносится на подложку, обычно с помощью 

пипетки или дозатора (рис. 3). Независимо от того, вращается ли подложка уже 

(динамическое спин-коатинг) или начинает вращаться после нанесения 

(статический спин-коатинг), центробежная сила позволит раствору растечься 

по поверхности подложки. 

Затем подложка достигает желаемой скорости вращения - либо сразу, 

либо после этапа вращения на низкой скорости. На этом этапе большая часть 

раствора уходит с подложки. Изначально жидкость может вращаться с другой 

скоростью, чем подложка, но в конце концов скорости вращения будут 

совпадать. Слой жидкости начинается уменьшаться (на это будет влиять 

вязкость раствора) за счет того, что раствор будет улетать с поверхности в 

стороны, что может проявляться в изменении цвета слоя из-за 

интерференционных эффектов. Когда цвет перестает изменяться, это обычно 

указывает на то, что пленка сформировалась. Иногда наблюдаются краевые 

дефекты, так как жидкость формирует капли на краю подложки, когда улетает 

в стороны. Когда отток жидкости прекращается, начинается испарение 
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растворителя. Скорость его испарения будет зависеть от летучести 

растворителя, температуры, давления паров и окружающих условий. 

Неоднородности в скорости испарения, например, на краю подложки, может 

вызывать соответствующие неоднородности в пленке. 

 

 
Рисунок 3 – Пример статического спин-коатинга раствора небольших 

молекул. (1) На подложку наносят раствор молекул. (2) Подложка вращается 

на большой скорости, и раствор разлетается в стороны. (3) Поверхностное 

натяжение и испарение формируют тонкий слой прежде, чем пленка 

полностью высохнет, оставив только молекулы на поверхности (4) 

 

Основными преимуществами спин-коатинга являются простота и 

относительная легкость воспроизведения процесса, а также возможность 

получения тонкого и равномерного покрытия различной толщины, что делает 

его идеальным как для исследований, так и для быстрого прототипирования. 

Возможность использования высоких скоростей вращения приводит к 

быстрым временам сушки (благодаря большим воздушным потокам), что, в 

свою очередь, обеспечивает высокую консистенцию как на макроскопическом, 

так и на наномасштабном уровне и часто исключает необходимость 

дополнительной термической просушки после нанесения. 

Спин-коатинг является очень экономичным способом пакетного нанесения 

слоев на одиночные подложки по сравнению с другими методами, многие из 

которых требуют более дорогого оборудования и высокоэнергетических 

процессов. 

Основным недостатком спин-коатинга является то, что фактическое 

использование наносимого материала в процессе спин-коатинга обычно очень 

низкое (около 10% или меньше), а остальное отбрасывается в сторону и 

теряется. Это обычно не является проблемой для исследовательских задач, но 
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явно является расточительным для крупномасштабного производства. 

Быстрые времена сушки могут привести к более низкой производительности 

для некоторых конкретных нанотехнологий (например, малых молекулярных 

OFET), которые требуют времени для самосборки и/или кристаллизации. 

Несмотря на эти недостатки, спин-коатинг часто используется из-за своей 

простоты в большинстве академических исследований и промышленных 

процессов, где требуется создание тонкого и равномерного покрытия. 

При этом следует отметить, что, несмотря на кажущуюся простоту спин-

коатинга, необходимо понимание механизмов формирования пленок, которые 

позволяют оператору влиять на толщину пленок посредством варьирования 

параметров нанесения. В первую очередь рассмотрим уравнение для толщины 

получаемой пленки, которая обратно пропорциональна квадратному корню из 

угловой скорости вращения ω или количеству оборотов в минуту (RPM – 

rotation per minute): 

hf ~
1

√ω
~

1

RPM
 .      (1) 

Можно рассчитать кривую спин-коатинга из этого уравнения, которая 

будет показывать зависимость толщины hf от скорости вращения ω (рис. 4). 

Однако точная толщина пленки будет зависеть от концентрации материала и 

скорости испарения растворителя (которая, в свою очередь, зависит от 

вязкости растворителя, давления паров, температуры и влажности 

окружающей среды), поэтому для новых материалов такие кривые обычно 

определяются эмпирически с помощью профилометра или эллипсометра. На 

основе одного или нескольких измерений можно рассчитать кривую толщины 

с высокой точностью. 

 
Рисунок 4 – Кривая зависимости толщины слоя в нанометрах, 

полученного методом спин-коатинга, от скорости вращения (количества 

оборотов в минуту – RPM) 

 

Однако это уравнение (1) не всегда применимо и не позволяет 

предсказывать толщину пленки без экспериментальных данных. Были также 

предприняты несколько попыток описать процесс более строгим образом, 

например, с учетом летучести растворителя, вязкости наносимого раствора.  

При отсутствии приборов для прямого измерения толщина пленки может 

оцениваться косвенно через её оптические свойства. Эта оценка основана на 
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законе Бугера–Ламберта–Бера, который связывает оптическую плотность D 

прозрачной среды с её толщиной и концентрацией поглощающего вещества: 

D = ε ⋅ c ⋅ h , (2) 
где: 

• D — оптическая плотность (безразмерная величина),

• ε — молярный коэффициент поглощения (характеристика вещества при

заданной длине волны),

• c — концентрация поглощающего компонента в плёнке (моль/л),

• h — толщина поглощающего слоя (см).

Если использовать один и тот же раствор, то концентрация и

молекулярный коэффициент остаются неизменными при разной толщине 

пленки. Следовательно, оптическая плотность прямо пропорциональна 

толщине: 

D~h .                (3) 

Объединяя (1) и (3), получаем предсказание для эксперимента: 

D~
1

√RPM
 . (4) 

Также следует отметить, что диапазон доступных скоростей вращения 

важен, поскольку он определяет диапазон толщин, которые могут быть 

достигнуты из данного раствора. В общем случае, покрытия методом спин-

коатинга позволяют легко получать пленки при скоростях вращения от 

примерно 1000 об/мин и выше, но при определенных условиях пленки могут 

быть получены и на скоростях около 500 или 600 об/мин. Большинство 

обычных спин-коатеров позволяют получать скорости до 10 000 об/мин. Таким 

образом, нормальный диапазон рабочих скоростей центрифугирования 

создания покрытий позволяет менять толщины пленок в √20~4.5 раза. 

Например, раствор, который дает толщину пленки 10 нм при 6000 об/мин, 

даст толщину около 32 нм при 600 об/мин, и если требуется более толстая 

пленка, то концентрация раствора должна быть увеличена. И наоборот, если 

раствор дает толщину 100 нм при 600 об/мин, то минимальная толщина, 

которая может быть достигнута без разбавления раствора, будет 31,25 нм. 

Зависимость от квадратного корня скорости вращения является как 

преимуществом, так и недостатком. Недостаток заключается в том, что это 

означает, что толщины, которые могут быть достигнуты из данного раствора, 

охватывает относительно узкий диапазон (до 4.5 раза). С другой стороны, 

преимущество заключается в том, что это позволяет точно контролировать  
толщину пленки в этом диапазоне. 

Максимальная толщина, которая может быть произведена при данной 

комбинации материала/растворителя, также зависит от максимальной 

концентрации, в которой материал может быть растворен в растворителе. Для 

материалов с высокой растворимостью (100 мг/мл или выше) толщины >1 мкм 

могут быть достигнуты. Между тем, для некоторых сополимеров с низкой 

растворимостью (несколько мг/мл) максимальная толщина может быть 

ограничена 20 нм или около того. При низких концентрациях толщина пленки 
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приблизительно линейно зависит от концентрации материала в наносимой 

растворе, однако при увеличении концентраций это будет влиять на вязкость 

раствора, и, таким образом, будет развиваться нелинейная зависимость. 

Для большинства стандартных методов центрифугирования 

предполагается, что подложка вращается до момента испарения растворителя. 

Таким образом, это будет главным образом зависеть от температуры кипения 

и давления паров используемого растворителя, а также от окружающих 

условий (температуры и влажности), в которых выполняется 

центрифугирование. Для большинства растворителей длительность 

центрифугирования в 30 секунд обычно более чем достаточна и поэтому она 

рекомендуется как стартовая точка для большинства процессов (табл. 1). 

 

Таблица 1 – Основные растворители, для которых длительность 

центрифугирования 30 секунд обычно достаточна, и те, для которых 

требуются более длительные сроки 

Обычно достаточна 30 секунд Требуются более длительные сроки 

Вода Дихлорбензол 

Изопропанол (IPA) Трихлорбензол 

Этанол Диодоктан 

Метанол Октандитиол 

Ацетон Глицерин 

Бутанон 
 

Толуол 
 

Ксилол 
 

Хлороформ 
 

Хлорбензол  

 

Для растворителей с более высокой температурой кипения (и/или более 

низким давлением паров) процесс сушки может занять значительно больше 

времени (до десяти минут в некоторых случаях), и поэтому эти растворители 

чаще всего используются либо как добавки, либо с дополнительными шагами 

сушки. 

В целом, предпочтительным для центрифугирования является 

динамический метод нанесения, поскольку это более контролируемый 

процесс, который обеспечивает воспроизводимость на подложках. Это 

происходит потому, что растворитель имеет меньше времени для испарения 

перед началом вращения, и скорость раскрутки и время разлета менее 

критичны. Динамический метод нанесения также использует меньше раствора 

вещества в целом, хотя это зависит от смачивающих свойств поверхности. 

Недостатком динамического метода нанесения является то, что он 

становится все более сложным для получения пленки, покрывающей всю 

поверхность, при использовании низких скоростей вращения (ниже 1000 

об/мин) или очень вязких растворов. Это происходит потому, что нет 

достаточной центробежной силы, чтобы растянуть жидкость по поверхности, 
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и более низкая скорость вращения также означает, что есть больше шансов, что 

раствор растечётся до того, как подложка завершит полный оборот (при 600 

об/мин подложка вращается раз в 0,1 секунды, что соответствует быстрому 

разливу капель). Поэтому в целом рекомендуют использовать статический 

метод нанесения при 500 об/мин или ниже, а с диапазона 500–1000 об/мин 

можно использовать любой метод. 

Для нанесения обычно используют около 20 мкл для большинства общих 

растворов при нанесении на подложки диаметром 20 мм или около 100 мкл для 

подложек диаметром 50 мм. Однако, если есть проблема со смачиванием, то 

следует увеличить наносимый раствор. 

Чтобы получить высококачественную и однородную тонкую пленку, 

необходимо соблюдать следующие правила: 

• Подложка должна достичь желаемой скорости вращения перед 

нанесением (обычно только несколько секунд). 

• Раствора материала должен наноситься в центр подложки, иначе 

может образоваться пробел в середине. 

• Раствор должен быть нанесен одним быстрым движением в одной 

капле, чтобы предотвратить формирования многослойного 

покрытия 

• Не должно быть никаких пузырей, выдуваемых на поверхность из 

пипетки / дозатора, и её кончик никогда не должен касаться 

вращающейся подложки. 

Когда скорость вращения уменьшают ниже 1000 об/мин или используют 

очень вязкий раствор, становится все более сложным получить 

высококачественную пленку. Поэтому, если возможно, рекомендуется 

увеличить концентрацию или изменить растворитель, чтобы обеспечить 

центрифугирование выше этой скорости. Однако есть много случаев в 

нанотехнология, где это либо нежелательно, либо невозможно. Например, 

лучше кристаллизация происходит при низких скоростях, и некоторые 

материалы просто не имеют достаточной растворимости, чтобы достичь 

желаемой толщины при 1000 об/мин. 

При использовании статического нанесения раствором обычно 

покрывается вся подложка (или её центр) перед началом центрифугирования. 

Однако это само по себе может вызвать несколько проблем. Первая проблема 

заключается в том, что если поверхность подложки не обеспечивает хорошего 

смачивания для раствора, то обычно необходимо использовать кончик 

пипетки, чтобы "размазать" раствор по поверхности. Также следует помнить, 

что кончик пипетки или дозатора не должен касаться поверхности подложки, 

так как это может изменить свойства поверхности или повредить ее 

приповерхностные слои. 

Критически важным параметром для статического нанесения является 

давление насыщенного пара растворителя, оно определяет, насколько 

молекулы растворителя связаны друг с другом, и фактически влияет на 

скорость испарения. Например, растворитель хлороформ имеет относительно 
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высокое давление насыщенного пара (в 10 раз выше, чем у воды), что приводит 

к его быстрому испарению. Поэтому время между нанесением раствора и 

вращением подложки становится критически важным в случае нанесения 

растворов из хлороформа. Именно поэтому воспроизводимость толщин и 

качества пленок при статическом нанесении низкая, и рекомендуется 

использовать именно динамический спин-коатинг. 

 

2.2 Ход работы 

Оборудование и материалы: 

• Спин-коатер SPIN150 

• Спектрофотометр СФ-56 

• Подложки из стекла (3 штуки) 

• Раствор красителя 

• Пипетка / дозатор 

 

1. Возьмите три чистые стеклянные подложки и очистите их с 

помощью воды или изопропанола. Это необходимо для обеспечения чистоты 

поверхности и предотвращения образования дефектов на пленке. 

2. Включите спин-коатер SPIN150 согласно инструкции. Установите 

одну из подложек на столик, после чего включите вакуумную фиксацию, чтобы 

подложка не сдвинулась при вращении. 

3. Исходя из рисунка 4, выберите три скорости, которые будут давать 

значительную разницу в толщине, и запрограммируйте их на спин-коатере. 

Учтите, что после накапывания раствора подложка должна вращаться не менее 

30 секунд — этого достаточно для удаления избытка раствора и испарения 

растворителя (для типичных растворителей: спирты, ацетон, толуол и др.). 

4. Нанесите 20 мкл раствора красителя в центр вращающейся 

подложки с помощью пипетки-дозатора. Не касайтесь кончиком пипетки 

поверхности подложки. 

5. Повторите процедуру для остальных двух подложек с новыми 

значениями скорости. Используйте один и тот же раствор и один и тот же 

дозатор, чтобы объём и концентрация были идентичны. 

6. Включите спектрофотометр СФ-56 и измерьте спектры 

экстинкции полученных образцов в диапазоне 200–11000 нм. Решите, каким 

приемом вы будете пользоваться, чтобы получить спектры поглощения в 

значениях оптической плотности. 

7. Для анализа выберите длину волны, соответствующую максимуму 

поглощения в спектре пленки, нанесённой при наименьшей скорости (обычно 

это даёт наибольшую оптическую плотность и лучшее отношение 

сигнал/шум). Запишите значения оптической плотности Dmax на выбранной 

длине волны для всех трёх скоростей в таблицу 2. 

8. Постройте два графика на одной оси: экспериментальную кривую 

Dmax(RPM) и её аппроксимацию. 
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Таблица 2 – Величины максимальной оптической плотности при 

различных значениях количества оборотов в минуту 

RPM, об/мин Dmax 

  

  

  

Примечание: если поглощение при разных скоростях почти одинаково, 

это может указывать на предел чувствительности — пленка стала слишком 

тонкой. 

9. В отчете следует сделать вывод о том, подтверждается ли 

теоретическая зависимость толщины от скорости качественно и 

количественно. При какой скорости достигается наилучшее качество пленки 

(равномерность, отсутствие дефектов)? Какие факторы могли повлиять на 

отклонение от теории? 

 

2.3 Вопросы для самопроверки 

1. Какие три основных этапа выделяют в процессе спин-коатинга? 

2. Почему толщина пленки уменьшается с ростом скорости 

вращения? 

3. Запишите теоретическую зависимость толщины пленки от 

скорости вращения. Какой это тип зависимости? 

4. Что такое динамический и статический методы нанесения? Чем 

они отличаются и какой предпочтительнее? 

5. Какие параметры раствора (кроме скорости вращения) влияют на 

толщину пленки? 

6. Сформулируйте закон Бугера–Ламберта–Бера. Как он связывает 

оптическую плотность и толщину пленки? 

7. Почему в данной работе можно использовать оптическую 

плотность как меру толщины? 

8. Почему спин-коатинг считается «расточительным» методом с 

точки зрения расхода материала? 

9. Вы получили почти одинаковые значения оптической плотности 

при разных скоростях. Как это можно интерпретировать? 

10. Чем вы объясните отклонение экспериментальных данных от 

теоретической кривой? 

11. Как изменится результат, если использовать растворитель с 

высокой температурой кипения (например, дихлорбензол) без увеличения 

времени вращения? 

12. Можно ли по цвету пленки на глаз оценить её толщину? Если да, 

то почему? 

  



- 23 - 
 

3 ЛАБОРАТОРНАЯ РАБОТА  

«АНАЛИЗ СЭМ-ИЗОБРАЖЕНИЙ ОСТРОВКОВЫХ ПЛЕНОК 

МЕТАЛЛОВ» 

 

Целью работы: освоить подходы для автоматизированного анализа 

изображений, полученных методами микроскопии, на примере СЭМ-

изображений островковых пленок благородных металлов. 

 

3.1 Теоретическая часть 

Интерес к наноструктурам на основе благородных металлов связан с их 

уникальными функциональными свойствами и перспективами практического 

применения. Золотые и серебряные наночастицы, например, нашли 

применение в биомедицине: их используют для таргетной доставки 

лекарственных препаратов к опухолевым клеткам и в фототермической 

терапии злокачественных новообразований. Отдельного внимания 

заслуживают антимикробные свойства таких наноматериалов: серебряные 

наночастицы эффективны в качестве биоцидов, а также позволяют 

визуализировать патологически изменённые участки тканей благодаря 

плазмонному резонансу. 

Одной из ключевых особенностей наночастиц благородных металлов 

является высокая чувствительность их оптических характеристик к 

изменениям внешней среды. Эта особенность лежит в основе работы 

плазмонных сенсоров: при взаимодействии наночастиц с определёнными 

химическими или биологическими агентами происходит сдвиг плазмонного 

резонанса, который часто проявляется в виде заметного изменения цвета 

коллоидного раствора. Такой эффект позволяет визуально или 

спектроскопически регистрировать присутствие анализируемых веществ даже 

в малых концентрациях. 

Ещё одно направление – использование наночастиц для усиления 

оптических сигналов. Благодаря локальному усилению электромагнитного 

поля вблизи поверхности частиц достигается значительное повышение 

эффективности комбинационного рассеяния и люминесценции. На этой 

основе разрабатываются компактные наноразмерные источники света, 

перспективные для интегральной оптоэлектроники, а также элементы для 

оптической обработки и хранения информации. Подобные решения могут 

улучшить характеристики фотоприёмников и повысить квантовый выход 

солнечных элементов. 

Синтез металлических наночастиц осуществляется двумя принципиально 

различными подходами. Методы «сверху вниз» предполагают физическое 

дробление массивного материала до наноразмерного состояния. Типичный 

пример – лазерная абляция, при которой импульсный лазер испаряет вещество 

мишени в вакууме или газовой среде с образованием наночастиц. Подход 

«снизу вверх» основан на сборке наноструктур из отдельных атомов или 

молекул; наиболее распространён химический синтез в растворах, где 



- 24 - 
 

восстановление ионов металла приводит к образованию коллоидных частиц. 

Отдельно выделяют физические методы газофазного осаждения, такие как 

термическое испарение в вакууме; биосинтез с участием микроорганизмов 

относится к самостоятельному классу методов и не является физическим. 

В настоящей работе объектом исследования служат островковые плёнки 

благородных металлов, сформированные на диэлектрических подложках 

методом физического осаждения из газовой фазы (PVD). Свойства 

получаемых наноструктур в значительной степени определяются параметрами 

процесса осаждения. Так, скорость напыления влияет на плотность 

зародышей: при высокой скорости формируются многочисленные мелкие 

островки, тогда как низкая скорость способствует образованию более крупных 

и монодисперсных структур. Температура подложки определяет подвижность 

адсорбированных атомов на поверхности – при повышенных температурах 

усиливается поверхностная диффузия, что приводит к срастанию островков и 

формированию сферообразных частиц и узким распределением по размерам. 

Давление остаточных газов в вакуумной камере влияет на среднюю длину 

свободного пробега испарённых атомов и, как следствие, на агрегацию частиц 

в газовой фазе и на подложке. 

Для оценки морфологии островковых плёнок применяются спектральные 

методы, однако они дают лишь косвенную информацию о размерах 

наноструктур. Более достоверные данные позволяют получить изображения, 

полученные с помощью сканирующего электронного микроскопа (СЭМ). Тем 

не менее, сами по себе микрофотографии не содержат количественных 

характеристик – они лишь визуализируют ограниченный участок поверхности. 

Для перехода от изображения к численным параметрам применяется 

программная обработка, в частности, с использованием пакета ImageJ – 

бесплатного инструмента, широко распространённого в материаловедческих 

исследованиях. 

Анализ СЭМ-изображений островковых плёнок в ImageJ включает 

несколько этапов. Сначала изображение импортируется в подходящем формате 

(TIFF, PNG и др.), после чего проводится предварительная обработка: 

подавление шума, коррекция контраста и яркости для улучшения 

различимости островков на фоне подложки. Затем выполняется калибровка 

масштаба по известной шкале на изображении. Ключевым шагом является 

сегментация: с помощью пороговой бинаризации выделяются области, 

соответствующие металлическим островкам. После этого программа 

автоматически рассчитывает морфометрические параметры, такие как 

площадь, периметр, эквивалентный диаметр, коэффициент формы для каждого 

объекта. На основе полученных данных строится статистика распределения по 

размерам, определяются средние значения и стандартные отклонения. 

Результаты могут быть визуализированы в виде гистограмм или других 

графиков, а также экспортированы в табличные форматы (CSV, Excel) для 

последующего анализа. Таким образом, ImageJ предоставляет исследователям 

удобный и многофункциональный инструмент для анализа СЭМ-изображений 
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островковых пленок металлов, позволяя проводить как качественный, так и 

количественный анализ, например, дисперсии. 

Дисперсия островков по размерам — это мера разнообразия или 

распределения размеров островков (или наночастиц), образующихся на 

поверхности материала, например, при осаждении из газовой фазы или в 

процессе других методов синтеза.  

 

3.2 Ход работы 

Оборудование и материалы: 

• Компьютер с установленной программой ImageJ 

• СЭМ-изображение островковой пленки 

 

1. Подготовка изображения 

Загрузка изображения 

Запустите программу ImageJ. Откройте СЭМ-изображение через меню 

File → Open. Если наноостровки на изображении выглядят темнее фона (что 

характерно для вторичных электронов), выполните инверсию цветов: Edit → 

Invert. 

Калибровка масштаба 

1. Найдите на изображении масштабную линейку (scale bar). 

2. Инструментом Straight line измерьте её длину в пикселях (программа 

покажет значение в строке состояния). 

3. Перейдите в Analyze → Set Scale… и введите: 

o Known distance — реальную длину линейки (например, 100); 

o Pixel distance — измеренное вами количество пикселей (например, 

73); 

o Unit of length — единицу измерения (нм). 

4. Установите флажок Global, чтобы применить калибровку ко всем 

последующим измерениям. 

Предварительная обработка 

При наличии шумов выполните сглаживание: Process → Filters → 

Gaussian Blur (радиус 0,5–1,0 пикселя — подберите визуально, чтобы не 

размыть границы островков). 

2. Бинаризация изображения 

1. Преобразуйте изображение в 8-битный формат: Image → Type → 8-bit. 

2. Выполните пороговую сегментацию: Image → Adjust → Threshold… 

o Перемещая ползунки, добейтесь, чтобы выделены были только 

металлические островки (фон — чёрный, островки — красный). 

o Нажмите Apply. На выходе получите бинарное изображение 

(чёрно-белое). 

3. Анализ морфологии островков 

1. Настройте измеряемые параметры: Analyze → Set Measurements… 

Отметьте: 

o Area (площадь), 
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o Feret's diameter (максимальный размер), 

o Shape descriptors (включает Circularity и расчёт эквивалентного 

диаметра 𝑑 = 2√𝐴/𝜋), 

o Centroid (координаты центра).  

Убедитесь, что активна опция Limit to threshold. 

2. Запустите анализ частиц: Analyze → Analyze Particles… 

Установите параметры: 

o Size: укажите диапазон, исключающий шум; 

o Включите Display results и Outline (для визуального контроля 

выделения). 

Нажмите OK. В отдельном окне появится таблица с 

количественными данными по каждому островку. 

4. Расчёт статистических характеристик 

Распределение по размерам 

1. В окне результатов выделите столбец с эквивалентными диаметрами 

(Feret или рассчитанный через площадь). 

2. Выберите Analyze → Distribution… для построения гистограммы прямо 

в ImageJ, либо экспортируйте таблицу (File → Save As) в формат CSV 

для обработки в Excel или Origin. 

3. Рассчитайте средний диаметр 𝑑̄, стандартное отклонение 𝜎 и 

коэффициент вариации 𝐶𝑉 = 𝜎/𝑑̄. 

Заполненность поверхности 

Определите долю покрытия как отношение суммарной площади всех 

островков к площади анализируемого поля: 

𝜃 =
∑𝐴𝑖

𝐴изображения
× 100% . 

 

5. Оформление результатов 

В отчёт включите: 

• исходное СЭМ-изображение с масштабной линейкой; 

• скриншот бинарного изображения с наложенным контуром выделенных 

островков (Outline); 

• заполненные таблицы 3 (сводная статистика по изображению: 𝑑̄, 𝜎, 𝜃) и 

4 (гистограмма распределения по размерам); 

• график распределения с аппроксимацией нормальной (гауссовой) 

кривой. 

На основании значения коэффициента вариации и качества 

аппроксимации сделайте вывод о степени монодисперсности островковой 

плёнки и подтвердите или опровергните гипотезу о нормальном 

распределении размеров. 
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Таблица 3 - Статистики размеров островков и заполненность 

изображения 

Параметр Значение 

Средний размер (nm) 
 

Стандартное отклонение (nm) 
 

Минимальный размер (nm) 
 

Максимальный размер (nm) 
 

Дисперсия (nm²) 
 

Общая площадь изображения (nm²)  

Сумма площадей островков (nm²)  

Заполненность (%)  

 

Таблица 4 – Дисперсия по размерам 

Размер островка (nm) Количество островков Процент от общего 

количества (%) 

< X1 
  

X1 - X2 
  

X2 - X3 
  

... 
  

> Xn 
  

 

3.3 Вопросы для самопроверки 

1. Почему наночастицы благородных металлов (Au, Ag) широко 

используются в медицине и сенсорике? 

2. В чём принципиальное отличие подходов «сверху–вниз» и «снизу–

вверх» при синтезе наночастиц? Приведите по одному примеру для каждого. 

3. Какие три технологических параметра при физическом вакуумном 

осаждении (PVD) влияют на морфологию островковой пленки? Опишите, как 

именно каждый из них влияет на размер и форму островков. 

4. Что такое «островковая пленка» и на какой стадии роста она 

формируется? Почему она не сплошная? 

5. Почему именно СЭМ (а не, например, оптическая микроскопия) 

используется для анализа наноостровков? Каковы её преимущества и 

ограничения? 

6. Что такое дисперсия размеров наночастиц и почему она важна для 

функциональных свойств материала? 

7. Как связаны между собой площадь островка, диаметр Фере и 

реальная форма частицы? Почему используется понятие «эквивалентного 

диаметра»? 

8. Что означает «нормальное распределение размеров»? Как 

выглядит его гистограмма и как проверить, насколько близко распределение к 

нормальному? 

9. Что такое «заполненность» поверхности островковой пленкой? 

Как она связана со стадией роста пленки?  
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10. Почему распределение размеров в реальных наносистемах часто 

не является строго нормальным? 

11. Как проверить, что значения среднего размера и заполненности 

физически правдоподобны? Можете указать типичные диапазоны для 

островковых пленок. 

12. Что означает, если максимальный размер островка превышает 1 

мкм на СЭМ-изображении с масштабной линейкой 100 нм? 
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4 ЛАБОРАТОРНАЯ РАБОТА  

«НАБЛЮДЕНИЕ ВОЛНОВОДНОГО РАСПРОСТРАНЕНИЯ СВЕТА В 

ТОНКОЙ ПОЛИМЕРНОЙ ПЛЁНКЕ» 

 

Цель работы: экспериментально продемонстрировать явление 

волноводного распространения света в диэлектрической плёнке и оценить 

эффективный показатель преломления волноводной моды путём анализа угла 

связи лазерного луча с планарным волноводом. 

 

4.1 Теоретическая часть 

Планарные оптические волноводы представляют собой 

фундаментальную основу современной интегральной оптики и имеют 

исключительное значение в развитии как базовых научных исследований, так 

и практических приложений в волоконной и интегральной оптоэлектронике. 

Изучение таких структур необходимо для понимания принципов 

распространения электромагнитных волн в ограниченных диэлектрических 

средах, что имеет прямое приложение при разработке оптических датчиков, 

фотонных интегральных схем, спектроанализаторов и других устройств 

современной фотоники.  

Планарным (или плоским) волноводом называют оптическую структуру, 

геометрически ограниченную лишь в одном направлении и однородную во 

всех остальных направлениях. Простейший планарный волновод состоит из 

плоского слоя (пленки) толщиной h, обладающего показателем 

преломления nf, который размещен между подложкой с показателем 

преломления ns и покровным материалом с показателем преломления nc.  В 

большинстве случаев роль покровного материала выполняет воздух, для 

которого nc = 1. Для надлежащего функционирования волновода необходимо, 

чтобы выполнялось условие nf > ns ≥ nc, то есть показатель преломления 

пленки должен быть больше показателей преломления окружающих сред. 

В геометрическом отношении свет предполагается распространяющимся 

вдоль волновода (обычно обозначаемого как направление z или x), тогда как в 

перпендикулярном направлении (обозначаемом как y) распространение 

ограничено толщиной пленки. Такая структура называется планарной в силу 

того, что волновод образует плоский слой, в отличие от канальных (трехмерно 

ограниченных) или волоконных волноводов. Физическая простота планарных 

волноводов делает их идеальным объектом для демонстрации 

фундаментальных принципов волноводного распространения света, в то время 

как их практическое применение охватывает широкий спектр интегральных 

оптических устройств. 

Условия возбуждения волноводной моды в тонкой пленке 

Возбуждение волноводной моды — это процесс установления 

стационарного колебания электромагнитного поля внутри пленки, при 

котором энергия света захватывается волноводом и распространяется вдоль 

него с минимальными потерями. Для того чтобы в пленке возникла 
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волноводная мода, необходимо одновременное выполнение двух 

фундаментальных условий: 

1) Полное внутреннее отражение на обеих границах пленки. Когда луч 

света, распространяющийся внутри пленки, встречает границу раздела с менее 

плотной средой (подложкой или воздухом), он может либо преломиться в эту 

среду, либо полностью отразиться обратно в пленку. Полное внутреннее 

отражение происходит, когда угол падения луча на границу раздела превышает 

критический угол. Для границы пленка-подложка критический угол 

определяется как 

θs = arcsin (
ns

nf
), 

а для границы пленка-покровная среда: 

θc = arcsin (
nc

nf
) . 

Поскольку nc < ns < nf, то θc < θs, и условие полного внутреннего 

отражения на обеих границах требует, чтобы угол падения удовлетворял 

неравенству: θ > θs. 

2) Выполнение дисперсионного уравнения. Одного лишь условия 

полного внутреннего отражения недостаточно для установления стационарной 

волноводной моды. Дополнительное ограничение накладывается 

требованием, чтобы фазовый набег волны за один полный цикл отражения от 

границ пленки был кратен 2π. Это условие математически выражается 

дисперсионным уравнением, которое для планарного волновода имеет вид: 

arctan [
√nf

2sin 2 θ−ns
2

nfcos θ
] + arctan [

√nf
2sin 2 θ−nc

2

nfcos θ
] = Nπ +

bπ

2
, 

где N = 0,1,2, . .. — целое число, определяющее номер моды, а 

коэффициент b = 0 для поперечно-электрических (ТЕ) мод и b = 2 для 

поперечно-магнитных (ТМ) мод. 

Физический смысл этого уравнения состоит в том, что существует 

дискретный набор углов распространения θ, при которых установятся 

стационарные волноводные моды. Каждому углу соответствует своя мода с 

определенным номером и характеристиками распределения поля по толщине 

пленки. Дисперсионное уравнение показывает, что при увеличении толщины 

пленки, увеличении разности показателей преломления или уменьшении 

длины волны излучения число поддерживаемых волноводом мод 

увеличивается. 

Эффективный показатель преломления — это одна из самых важных 

характеристик волноводной моды, которая связывает макроскопические 

параметры волноводной структуры с параметрами распространяющейся 

волны. Его величина всегда находится между показателями преломления 

подложки и пленки. Когда neff = nf, угол распространения θ = 90°, и волна 

распространяется параллельно границам пленки. Когда neff приближается 

к ns, волна становится более поперечной, а в пределе, когда neff = ns, 

наступает отсечка моды — мода перестает быть волноводной и начинает 
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терять энергию в подложку. Физически эффективный показатель преломления 

можно интерпретировать как показатель преломления, который «видит» 

плоская волна, распространяющаяся вдоль волновода со скоростью c/neff.  

Методы возбуждение волноводных мод 

При исследовании планарных волноводов существует несколько способов 

ввода оптического излучения в волновод для возбуждения волноводных мод. 

Два основных метода — торцевой (прямой) ввод света через торец пленки и 

ввод с помощью призменного элемента связи — представляют собой 

практически реализуемые подходы, каждый из которых имеет свои 

преимущества и недостатки. 

Принципиально наиболее простым способом ввода излучения в 

планарный волновод является направление светового луча непосредственно на 

полированный торец пленки под определенным углом к нормали. Для того 

чтобы введенный свет превратился в волноводную моду, необходимо, чтобы 

луч, распространяющийся внутри пленки, удовлетворял условиям полного 

внутреннего отражения на обеих границах пленки.  

Однако выполнения условия полного внутреннего отражения все еще 

недостаточно для возбуждения стационарной волноводной моды. 

Дополнительное требование состоит в том, чтобы угол распространения луча 

удовлетворял дисперсионному уравнению волновода. Таким образом, не все 

углы падения в пределах области полного внутреннего отражения приводят к 

возбуждению волноводных мод — возможны только дискретные углы, 

соответствующие определенным модам. 

Эффективность торцевого ввода зависит от угла падения и от 

согласования распределения интенсивности падающего пучка с 

распределением поля волноводной моды. Если падающий пучок имеет 

однородное или гауссово распределение, эффективность ввода обычно не 

превышает 80%, так как часть энергии не совпадает с модовой структурой. При 

необходимости повысить эффективность торцевого ввода используются 

фокусирующие линзы, которые концентрируют свет в области входного торца 

волновода. Однако субмикронные размеры волноводной пленки (толщина 

обычно 1–5 мкм) делают такую юстировку критичной и практически 

применимой только в лабораторных условиях. 

Важной особенностью торцевого возбуждения является то, что при 

увеличении угла падения внутри пленки можно последовательно наблюдать 

переход от условия, когда свет распространяется в подложку (низкие углы), к 

режиму волноводного распространения (средние углы) и, наконец, к режиму, 

когда свет распространяется почти параллельно плоскости пленки (большие 

углы). На выходном торце волновода видна яркая полоска света, 

характеризующая интенсивность волноводной моды. 

Альтернативным методом, обеспечивающим более высокую 

эффективность возбуждения и большую гибкость при выборе мод, является 

использование призменного элемента связи. Этот метод основан на явлении 
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оптического туннелирования через воздушный зазор между призмой и 

волноводом. 

Видимость волноводного луча 

При анализе волноводного распространения используется 

геометрическая модель, в которой волноводная мода представляется как 

совокупность лучей, многократно отражающихся от границ пленки под 

определенным углом θ. Однако такое представление является удобной 

математической конструкцией, а не описанием реального физического 

объекта. 

При прямом визуальном наблюдении волновода в обычных условиях 

(проходящее или отраженное освещение) обычно невозможно увидеть какой-

либо выделенный луч, распространяющийся под определенным углом. Вместо 

этого наблюдается либо равномерное излучение на выходном торце волновода, 

либо сложная интерференционная картина на поверхности пленки. Это 

объясняется тем, что волноводное распространение имеет волновой характер, 

и электромагнитное поле распределено по объему пленки в соответствии с 

модовой структурой, а не как траектория отдельного луча. 

Однако в определенных экспериментальных ситуациях волноводный луч 

может быть частично визуализирован. При использовании торцевого 

возбуждения на выходном торце волновода видна яркая полоска света, ширина 

и расположение которой отражает распределение интенсивности волноводной 

моды. При призменном возбуждении в области выводящей призмы видны 

отдельные яркие полоски для каждой возбужденной моды. При наличии 

дефектов или нарушений на границах волновода происходит боковое 

рассеяние света, и волновод может светиться вдоль своей длины при 

наблюдении сбоку. 

Таким образом, волноводный луч — это, по сути, геометрическая модель, 

удобная для анализа волноводных явлений на основе принципов лучевой 

оптики и условия полного внутреннего отражения. Физическое описание 

волноводной моды требует электромагнитного анализа, в котором мода 

представляется как стоячая волна по толщине пленки, которая 

распространяется как целое вдоль волновода с фазовой скоростью c/neff. 

Видимое же на выходе волновода излучение — это результат взаимодействия 

волноводной волны с границами, дефектами и выходными элементами 

структуры. 

 

4.2 Ход работы 

Оборудование и материалы 

• Гелий-неоновый лазер (He-Ne, λ = 632,8 нм) 

• Спинкоатер SPIN150  

• Транспортир 

• Держатель для подложки с возможностью изменения угла падения луча 

• Белый экран  

• Линейка металлическая (не менее 30 см) для калибровки масштаба 
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• Раствор ПММА в хлороформе с концентрацией 1 wt.%  

• Стеклянные предметные стекла  

 

1. Соблюдайте общие правила работы в химической лаборатории. 

Очистите предметное стекло с помощью этанола или изопропанола. 

2. Нанесите раствор ПММА на спин-коатере SPIN 150 используя 

динамический режим, скорость вращения 3000 об/мин в течение 30 с должна 

дать толщину пленки около 2–3 мкм.  

3. Соблюдайте технику безопасности при работе на лазерной 

установке (аппарате). Подготовьте оптическую схему на основе 

последовательной установки He-Ne лазера, поворотного держателя с 

подложкой и белым экраном на расстоянии 10–30 см для наблюдения за 

рассеянной волноводной модой.  

4. Наведите лазерный луч так, чтобы он падал на торец подложки. 

5. Осуществите поиск волноводного режима, начиная с угла падения 

θ ≈ 30° от нормали к торцу подложки, медленно увеличивая угол с шагом с 

шагом 1–2°, наблюдая за экраном. Следите за появлением дополнительного 

светового пятна или линии, распространяющейся вдоль плёнки. По мере 

увеличения угла интенсивность волноводного луча на экране будет расти, а его 

положение будет изменяться. Когда интенсивность станет максимальной (при 

дальнейшем увеличении угла она начнет падать), то вы нашли так называемый 

угол связи α. Сфотографируйте экран при максимальной интенсивности 

волноводного луча. 

Важно: волноводный луч всегда идёт под острым углом относительно 

падающего луча (не совпадает с ним), потому что он распространяется в 

другом направлении, определяемом волновым вектором моды. 

6. Сфотографируйте экран при максимальной интенсивности 

волноводного луча.  

7. В отчете необходимо привести это изображение и описать 

наблюдаемые особенности волноводного луча на экране:  

• Форма (прямая линия, полоса, несколько линий) 

• Яркость (яркий, умеренный, слабый) 

• Однородность по длине (равномерная, неравномерная) 

• Цвет (красный, как у He-Ne лазера, или другой оттенок) 

• Боковые ветви или множественные линии (признак возбуждения 

нескольких мод) 

• Разрывы в распространении (дефекты в плёнке) 

• Краевое усиление интенсивности (краевые эффекты) 

8. Используя измеренный угол связи α и известный показатель 

преломления стекла (ns = 1.52), вычислите эффективный показатель 

преломления моды: 

neff = ns ⋅ sin α . 

9. Проверьте условие локализации моды: 
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nс < neff < nf , 

где nf ≈ 1,49 – показатель ПММА. 

10. Сделайте в отчете выводы относительно возможности 

подтверждения явления волноводного распространения, дайте оценку 

эффективного показателя преломления, применимости результатов. 

 

4.3 Вопросы для самопроверки 

1. Объясните, почему свет может быть захвачен внутри плёнки без 

зеркальных покрытий. Какое условие должно выполняться для полного 

внутреннего отражения? 

2. Запишите выражение для эффективного показателя преломления 

моды через угол связи и показатель преломления подложки. 

3. Как связаны угол падения лазерного луча на торец подложки и угол 

распространения волноводной моды? 

4. Какие параметры плёнки влияют на угол связи? 

5. Почему в реальных волноводах часто наблюдается несколько 

волноводных лучей (несколько мод) вместо одного? 

6. Как принцип волноводного распространения используется в 

волоконной оптике и интегральной фотонике? 

7. Что физически означает угол связи? Почему при этом угле 

происходит наиболее эффективное возбуждение волноводной моды? 

8. В идеальном волноводе свет не должен рассеиваться наружу. 

Почему же мы видим яркую линию, распространяющуюся вдоль плёнки? 

Какие эффекты это вызывают? 

9. Как изменится угол связи θ_c, если использовать более толстую 

или более плёнку? Обоснуйте качественно (без вычислений). 

10. Показатель преломления ПММА зависит от длины волны 

(дисперсия). Как это повлияет на угол связи, если использовать лазер другого 

цвета (например, зелёный He-Cd лазер на λ = 441 нм)? 

11. Проанализируйте источники погрешности в вашем эксперименте. 

Какие факторы могут привести к неточности в измерении α? Как их 

минимизировать? 

12. Если бы вы проектировали волновод для практического 

применения (например, в сенсоре или интегральной схеме), какие параметры 

плёнки (толщина, материал, показатель преломления) вы бы выбрали и 

почему? 
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